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1 Introduction 
This document presents a procedure to measure the in-situ sound diffraction of road traffic noise 

reducing devices in compliance with EN 1793-4, or of railway noise barriers in compliance 

with EN 16272-4, and is based on the following standards, equipment and software: 

 

1. EN 1793-3, normalized traffic noise spectrum [1]. 

2. EN 1793-4, in-situ sound diffraction of road traffic noise reducing devices [2]. 

3. EN 16272-3-2, normalized railway noise spectrum and single number ratings [3]. 

4. EN 16272-4, in-situ sound diffraction of railway noise barriers [4]. 

5. Zircon hardware (by Acoustics Engineering), consisting of the LS24 (or LS14) 

loudspeaker source, the MA25 microphone array with 5 microphones and the CI24 

control interface between a computer running Zircon software, and mentioned devices. 

6. Zircon software (by Acoustics Engineering), being DIRAC 7.3+ or ZIRCON 1.0+, 

acoustics measurement software that produces a stimulus to the source, captures 

response signals from the measurement grid, processes these to verify the validity of 

the measurements, and calculates the results to be reported according to the standards. 

 

In this procedure, familiarity with EN 1793-4 or EN 16272-4 and Zircon software is assumed. 

The explanations and screenshots are based on DIRAC, but largely similar with ZIRCON. 

 

In this document, a road traffic noise reducing device or railway noise barrier is denoted by 

NRD (Noise Reducing Device). 

 

This procedure presumes that, as prescribed by the standards, objects other than the NRD under 

test, potentially causing substantial parasitic reflections that might affect the measurement 

results, are kept at least 3 m from the microphones. 

 

Where the loudspeaker unit is denoted as LS24, it may be substituted by its predecessor LS14, 

the electric and acoustic characteristics of which are substantially the same. Nevertheless, for 

the safest operation at these typical NRD heights, the lower weight LS24 is recommended. 

  



 TN019 - Measuring DI www.acoustics-engineering.com 
 

 4  

2 Measuring Equipment 
2.1 Components 
The measuring equipment consists of the following components: 

 

1. Loudspeaker source: Zircon LS24, placed on its tripod using an ET24 extender tube 

and a TH24 tilt head. 

2. Microphone array: Zircon MA25 with 5 IEPE microphones, placed on its tripod using 

an ET24 extender tube. 

3. Control interface: Zircon CI24, comprising a multi-channel USB/Audio interface 

device with IEPE microphone inputs, and a power amplifier for the LS24. 

4. Speakon cable: 2 x CA12 (10 m) with coupler or CA12-20m (20 m) 

5. Multi-cable: CA24 (for 9-mics) or CA25 (thinner, for 5 mics) 

6. Windows PC running Zircon software. 

 

 

2.2 Cables 
The long distances require long cables to the LS24, the MA25 or both. Note that a long speaker 

cable is preferable to a long microphone cable. Assuming that the speaker cable is put over the 

NRD, a length of 20 m should do the job (CA12-20m). If such length is not needed in most 

other (non-diffraction) measurement situations, coupling two 10 m cables (CA12) may be 

preferable. 

 

The CA24 multi-cable (for 9 microphones) can be used with the MA25, but the CA25 cable 

(for 5 microphones) is thinner, and therefore somewhat easier to handle.  
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3 In-Office Installation and Preparation Procedure 
3.1 Introduction 
Hereafter, a kind of checklist is given for the in-office preparation of field measurements. Not 

all the instructions apply each time preparing a field measurement session, such as the CI24 

driver installation. 

 

1. Set up the MA25 tripod and take off the tripod head (with UNC 5/8” screw). 

 

 
 

2. Screw the tripod head tightly enough in the MA25 bottom plate to avoid any play. The 

ET24 extender tube is not convenient indoors, hence omitted here. 

3. Place the MA25 on its tripod and secure the tripod head with its screw. 

4. Insert 5 microphones (bayonet movement). 

 

           
 

5. Set up the LS24 tripod and take off the tripod head (with UNC 5/8” screw). 

6. Screw the tripod head tightly enough in the LS24 bottom plate to avoid any play. The 

ET24 extender tube is not convenient indoors, hence omitted here.  

7. Place the LS24 on its tripod and secure the tripod head with its screw. 

8. At the right side of the CI24, insert the short mains power interconnection cable and set 

the XR18 power switch to the On state. 

9. Connect the CI24 to the mains power through the included mains power cable. 
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CI24 mains power interconnection cable 

 

 

10. Connect the CI24 to the PC through the included USB cable. 

11. Attach the multi-cable to the MA25 and the CI24. 

12. Attach the Speakon cable to the LS24 and the CI24. 

13. Turn on the CI24 by the switch above the mains power inlet. If the green LED on the 

power amplifier does not light, check the power. If the orange LED on the XR18 unit 

does not light, turn on the XR18 using the switch at the right side or check the 

interconnection cable there. 

14. Install X18 USB Audio Driver on the PC (version 5.72.0, 2025-02-19). This driver can 

be found on the Behringer website by entering “XR18 driver” in the search field of the 

Download Center: 

Behringer | Downloads 

 

https://www.behringer.com/downloads.html
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15. On the PC, start the Zircon software, and then from the Setup menu choose Sound 

Device. 

16. From the Sound Device Setup window, select the line asio: X-AIR ASIO Driver for 

both input and output. Click ‘OK’ to save this setup under the name CI24. 

 

  
 

17. The Measurement window now displays the VU meters for all XR18 input channels: 

 

 
 

3.2 Startup sequence 
After setting up the XR18 in the Zircon software, the following startup sequence will normally 

be successful: 

1. Connect the USB cable and turn on the CI24 

2. Wait at least 11 seconds 

3. Start the Zircon software and open the Measurement window 
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Note however, that connection and startup order matters. After turning on the CI24, it takes 11 

seconds to complete starting up and, if the USB cable is connected, register with the Windows 

Device Manager, which then gets the ASIO driver up and running. When the Zircon software 

is started, it will check the availability of a valid ASIO driver only once and, upon opening the 

Measurement window, initialize it. Therefore: 

• If the Zircon Software is started while the ASIO driver is not (yet) running, opening the 

Measurement window will display the following error message, and require a restart of 

the Zircon Software, but now with the ASIO driver running: 

 

 
 

• If the Zircon Software is started while the ASIO driver is running, after which the CI24 

has been turned off or the USB cable disconnected, opening the Measurement window 

will display the following error message, and require a reopening of the Measurement 

window after restoring the connection: 

 

 

3.3 Dry run test 
The dry run test simulates part of a field measurement in order to recall procedure steps and 

prepare the session along a road or railway. 

 

3.3.1 Measurement (dry run) 
1. If applicable, on the Preset tab, load the Zircon DI setup. The preset name and 

associated sound device are displayed in the title bar. On the Device tab, sound device 

CI24 is selected. 

2. VU meters 1 through 5 should react to sound at microphones 1 through 5 respectively, 

and after clicking the Test button (mind the Gain!), a sweep should be heard from the 

LS24. Click the same button to stop the sweep. Note that for accurate source-receiver 

distance measurements, the loopback channel is used and set to 17. 
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3. Fill out the Project tab. Measured files will be saved in the designated folder. The file 

names will optionally include the Project and Location designations (menu Setup > 

Options > Autoname). In this example, Autoname is set to include the Project name 

(Barrier3), the Location name (FF), and the Source and Receiver numbers (SmRn, see 

step 6 below: Position tab) in the file names. 

 

 
 

4. On the Environment tab, you can enter the expected environmental conditions in the 

field. 

 

 
 

5. On the User Info tab, enter all remaining relevant measurement info. 
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6. On the Position tab, enter Source: 1 and Receiver: 1. 

 

 
 

7. Click the Test button, set the Gain slider to a reasonable sound level with respect to the 

background noise, and then click the Start button to perform the test measurement. 

8. The Project window opens and finally shows 5 impulse responses, representing the 

free-field results for source position S1. 
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9. By double-clicking an impulse response, DIRAC will display it in Impulse Response 

view, and you can zoom in to see more details (note that below image of a synthetic 

impulse response is for illustration purposes only). The window can be closed again by 

clicking the top right corner. 

 

 

 

10. Select the Graph view (menu View > Graph or  Graph button). 

11. Open the Properties dialog (Setup menu or Properties button). 

12. From the Parameter list on the left, select Levels > INR (Impulse response to Noise 

Ratio), and wait for the INR curves to appear. Below image of 5 synthetic impulse 

responses with identical and very high INR curves is for illustration purposes only, and 

not very realistic. 

13. The INR reflects the quality of an impulse response measurement and should preferably 

exceed 25 dB for each microphone and at all third octave frequencies from 100 Hz 

through 5 kHz. If this is not the case, then this might be due to background noise, 

environmental fluctuations or an incorrect setup. 

So, if necessary, repeat the measurement with a corrected setup and/or under improved 

conditions, such as an adjusted source signal level or a higher Receiver Pre-Average 

value in the Measurement window, until the INR values are good or at least optimal. 
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14. If the measurements were repeated under different conditions to optimize the INR, 

delete all intermediate trial impulse response files in the folder, and then restart the 

measurement under the current optimal condition. 

 

3.3.2 Processing (dry run) 
1. In the Project window, from the Process menu, select Zircon. 

2. Fill out the Zircon dialog box, entering the proper NRD Height and Adrienne temporal 

Window length, and selecting the Reference and Measurement groups. 
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3. It is not necessary now to click Process and carry out the calculations, yet it is 

recommended to prepare this dialog box before the field measurement session. 

4. Close the Zircon dialog box and in the Measurement window, set the Receiver Pre-

Average value to 16: the minimum required according to the standards. 

5. Quit the Zircon software and turn off the CI24 unit. 

6. The dry-run folder can now be deleted. 

 

3.4 LS24 and MA25 positioning 
Table 1 shows the nominal angles and tripod center positions for each of the four setups with 

Source positions S1 through S4. The x and y coordinates are relative to the NRD Measurement 

Position as defined in Figure 1. The z coordinates are relative to the NRD height. Details on the 

calculations of the angles and positions can be found in Chapter 6 (Appendix). 

 

Table 1. Angles and tripod positions versus Source position Sm. 

Component Parameter S1 S2 S3 S4 

LS24, MA25 Azimuth 0 0 45 45 

LS24 

Elevation 14 9 10 7 

X -2.12 -2.14 -2.09 -2.10 

Y 0 0 -2.09 -2.10 

Z -2.24 -1.88 -2.18 -1.82 

MA25 

X 2.11 2.11 2.08 2.08 

Y 0 0 2.08 2.08 

Z -2.49 -2.49 -2.49 -2.49 

 

The x coordinates are relative to the Reference Plane. To convert them to a more practical 

distance between tripod center and NRD, subtract part of the NRD thickness. For instance, with 

a constant NRD thickness of 0.50 m over the entire height, for S1 the LS24 tripod center must 

be placed at 2.12 – 0.25 = 1.87 m from the NRD. 

The z coordinates refer to the tripod head tops, and depend on the NRD height H. For instance, 

with H = 4.00 m (including added device, if present), for S1 the LS24 tripod head top height 

must be adjusted to 4.00 – 2.24 = 1.76 m. 

 

3.4.1 Survey measurements 
For survey measurements, changing the LS24 elevation between different setups may be 

omitted by using a fixed value of 10° for all Source positions Sm. This hardly affects the results 

thanks to the favorable directional characteristic of the LS24: at the resulting maximum angle 

error of 4°, the LS24 level deviates less than -0.2 dB at 5 kHz, and less than -0.1 dB at 4 kHz. 
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Figure 1. Definition of tripod positions relative to the NRD Measurement Position. 

 

3.4.2 Practical tables 
Table 1 can be used to build work tables for use in the field, by converting the coordinates to 

tripod-tripod distances, tripod-NRD distances and tripod heights. It is recommended to prepare 

these work tables in the office, in order to avoid calculation work in the field. Table 2 shows a 

template, where: 

 

• The bracketed values refer to a fixed 10° elevation, should that option be chosen. 

• DFF = Horizontal distance between tripod centers in free-field measurement 

• XLNRD = distance between LS24 tripod center and NRD 

• S = partial NRD thickness, measured from the Reference Plane in the LS24 direction, 

and at XLNRD measurement height 

• YL = LS24 tripod y-coordinate relative to the NRD Measurement Position as defined 

in Figure 1 

• ZLGND = LS24 tripod head top height relative to the ground 

• H = NRD height, with or without added device, whichever applies 
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• XMNRD = distance between MA25 tripod center and NRD 

• R = partial NRD thickness, measured from the Reference Plane in the MA25 direction, 

and at XMNRD measurement height 

• YM = MA25 tripod y-coordinate relative to the NRD Measurement Position as defined 

in Figure 1 

• ZMGND = MA25 tripod head top height relative to the ground 

 

Table 2. Angles and tripod positions versus Source position Sm. 

Parameter S1 S2 S3 S4 

Pos tab S1R1 S2R1 S3R6 S4R6 

Azimuth [°] 0 0 45 45 

Elevation [°] 14 (10) 9 (10) 10 (10) 7 (10) 

DFF [m] 4.23 (4.24) 4.25 (4.24) 5.90 (5.90) 5.91 (5.90) 

XLNRD [m] 2.12 (2.13) - S 2.14 (2.13) - S 2.09 (2.09) - S 2.10 (2.09) - S 

YL [m] 0 0 -2.09 -2.10 

ZLGND [m] H – 2.24 (2.24) H – 1.88 (1.89) H – 2.18 (2.18) H – 1.82 (1.83) 

XMNRD [m] 2.11 - R 2.11 - R 2.08 - R 2.08 - R 

YM [m] 0 0 2.08 2.08 

ZMGND [m] H – 2.49 H – 2.49 H – 2.49 H – 2.49 

 

Note that H depends on the situation (with or without added device), hence so do ZLGND and 

ZMGND. For the free-field measurements, H must be at least the height of the NRD without 

added device. 

3.5 Some tips 

1. Make sure that the tripods are high enough for the NRD, with the legs fully spread. 

2. The cable roll ties can also be used to tie the cables to the tripods. 

3. The great height of the source and receivers makes it difficult to move them, so this is 

better done with two persons. 

4. Placing 6 markers beforehand reduces the chance of mistakes and the amount of work 

when repeatedly using the same positions. 

5. It may be convenient to have both a tape measure and a laser measure. 

6. Bring rubber bands to secure typically loose parts of the source tripod, such as the 

crank, that otherwise might rattle during loud sine sweeps, which may be annoying. 

7. Avoid any contact of connectors with the ground. After releasing a connector, do not 

drop it on the ground, put it in a clean place. 

 

The preparations for the field measurements are now complete.  
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4 Field Measurement Procedure 

 

Notes 

1. Hereafter, text printed in italics refers to the terminology as used in the standards. 

2. The screenshots shown hereafter are for illustration purposes only. 

3. This procedure starts with the reference measurements, but it is also possible to start 

with the NRD measurements. 

 

4.1 Free-field (Reference) Measurements 

4.1.1 Introduction 
Reference measurements must be repeated for each measurement session, each 2 hours, and 

when measurement conditions such as temperature or relative humidity have changed 

significantly since the previous free-field measurements. 

 

To the extent applicable, follow the instructions hereafter (in subsections 4.1.2 through 

4.1.4) for source positions S1 through S4 respectively. 

 

In the end, the project will contain 20 free-field impulse responses. 
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4.1.2 Setup (free-field) 
Table 3 is a template for free-field measurements, representing a filled out copy of Table 2. 

When using a fixed 10° elevation, apply the bracketed values. 

 

Table 3. Free-field measurement angles and positions versus Source position Sm. 

Parameter S1 S2 S3 S4 

Pos tab S1R1 S2R1 S3R6 S4R6 

Azimuth [°] 0 0 45 45 

Elevation [°] 14 (10) 9 (10) 10 (10) 7 (10) 

DFF [m] 4.23 (4.24) 4.25 (4.24) 5.90 (5.90) 5.91 (5.90) 

XLNRD [m] 2.12 (2.13) - S 2.14 (2.13) - S 2.09 (2.09) - S 2.10 (2.09) - S 

YL [m] 0 0 -2.09 -2.10 

ZLGND [m] H – 2.24 (2.24) H – 1.88 (1.89) H – 2.18 (2.18) H – 1.82 (1.83) 

XMNRD [m] 2.11 - R 2.11 - R 2.08 - R 2.08 - R 

YM [m] 0 0 2.08 2.08 

ZMGND [m] H – 2.49 H – 2.49 H – 2.49 H – 2.49 

 

Tripods 

1. Place the LS24 and MA25 tripods at the proper distance DFF (Table 3), at least 3 m 

away from obstacles. If appropriate, first set out markings on the ground, and then place 

the tripods directly above them.  

2. Align the tripods vertically upwards, using the integrated bubble levels or separate spirit 

level, and/or by visual alignment with some vertical elements in the neighborhood. 

LS24 

1. Place the LS24 on a soft surface, e.g. its carry bag. 

2. Attach the speakon cable and the TH24 tilt head to the LS24, with the axis of rotation 

perpendicular to the speaker axis. 

3. Adjust the TH24 to the proper elevation (Table 3, LS24 ‘looking up’). 

4. Attach an ET24 extender tube to the TH24 swivel, and then the LS24 tripod head to the 

extender tube. 

5. Tie the cable to the tube using a tie-wrap. 

6. Place the head-ET24-TH24-LS24 assembly on top of the LS24 tripod, point the LS24 

to the receiver tripod and tighten the head screw. 

7. Lift the tripod head top to the proper height ZLGND (Table 3) through the telescope 

tube system and the crank, and lock it by firmly tightening the locking screws. 

8. Drape the cable down the tripod and tie it to the base. This will reduce the chance that 

the tripod is pulled over by tripping over the cable. 
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9. If necessary, adjust the LS24 azimuth (Table 3) only by applying the following 

sequence of actions to the tripod head: unlock – rotate - relock. Do not rotate the tube 

on top of the tripod head, to avoid accidently unscrewing it. 

MA25 

1. With the MA25 in its protective case, insert 5 microphones with windscreens. 

2. Attach a multi-cable and an ET24 extender tube to the MA25 microphone array, and 

then the MA25 tripod head to the extender tube. 

3. Tie the cable to the tube using a tie-wrap. 

4. Place the head-ET24-MA25 assembly on top of the MA25 tripod, point the 

microphones to the LS24 tripod and tighten the head screw. 

5. Lift the tripod head top to the proper height ZMGND (Table 3), using the tripod crank, 

and lock it by firmly tightening the locking screw. Do not release the crank without 

having locked the height. 

6. Drape the cable down the tripod and tie it to the base. 

7. If necessary, adjust the MA25 azimuth (Table 3) only by applying the following 

sequence of actions to the tripod head: unlock – rotate - relock. Do not rotate the tube 

on top of the tripod head, to avoid accidently unscrewing it. 

CI24 and Zircon software 

1. Place the CI24 and laptop in a suitable location relative to the LS24 and MA25. 

2. Connect the cables from the LS24 and the MA25 to the CI24. 

3. Connect the CI24 and the laptop to mains power. 

4. Connect the CI24 to the laptop and turn it on. 

5. Wait at least 11 s (see Section 3.2) and then start the Zircon software. 

6. Open the Measurement window and, if applicable, on the Preset tab load the proper 

setup. 

 

4.1.3 Measurement (free-field) 
1. Fill out the Project tab: the folder name for measurement files, the Project name, and 

the Location name (FF denotes free-field measurements). 
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2. On the Environment tab, enter the environmental conditions in the field. 

3. On the User Info tab, enter all remaining relevant measurement info. 

 

 
 

4. On the Position tab, enter the proper Source number m and Receiver number n (Table 

3, Pos tab). 

5. If this is not the first source position (m > 1), open the Project window and the current 

project, so the Zircon software can add subsequent free-field measurements to the 

reference Group. 

6. Click the Test button to check the signal, and then click the Start button to perform the 

measurement. 

7. After processing the measurements, the Zircon software adds 5 new free-field impulse 

responses to the current project. In case of no open project, the Zircon software will 

open the project window and create a new project. 

8. Save the project. 

 

4.1.4 Validation (free-field) 
1. Select the Graph view (menu View > Graph or  Graph button). 

2. Select parameter INR and wait for the INR curves to appear. 

3. If necessary, repeat the measurement with a corrected setup and/or under improved 

conditions, such as an increased Source Signal Gain or Receiver Pre-Average value, set 

in the Measurement window, until the INR values are good or optimal. 

 

As mentioned in Section 4.1.1, the project finally contains 20 free-field impulse responses. 
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4.2 NRD Measurements 

4.2.1 Introduction 
This part of the procedure must be executed for each measurement position at the NRD and 

each added device condition (with/without added device). 

 

To the extent applicable, follow the instructions in subsections 4.2.2 and 4.2.3 for Source 

positions S1 through S4 respectively, and repeat this for each NRD measurement position 

and applicable added device condition. 

 

4.2.2 Setup (NRD) 
Table 4 is a template for NRD measurements, representing a filled-out copy of Table 2. When 

using a fixed 10° elevation, apply the bracketed values. 

 

1. Place the LS24 and MA25 tripods at the proper distances XLNRD and XMNRD (Table 

4) to the NRD. If appropriate, first set out markings on the ground, and then place the 

tripods directly above them. 

2. Align the tripods vertically upwards. 

3. Adjust the LS24 tripod head top to the proper height ZLGND (Table 4). 

4. Adjust the MA25 tripod head top to the proper height ZMGND (Table 4). 

5. Place the CI24 and laptop in a suitable location relative to the LS24 and MA25. 
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Table 4. NRD measurement angles and positions versus Source position Sm. 

Parameter S1 S2 S3 S4 

Pos tab S1R1 S2R1 S3R6 S4R6 

Azimuth [°] 0 0 45 45 

Elevation [°] 14 (10) 9 (10) 10 (10) 7 (10) 

DFF [m] 4.23 (4.24) 4.25 (4.24) 5.90 (5.90) 5.91 (5.90) 

XLNRD [m] 2.12 (2.13) - S 2.14 (2.13) - S 2.09 (2.09) - S 2.10 (2.09) - S 

YL [m] 0 0 -2.09 -2.10 

ZLGND [m] H – 2.24 (2.24) H – 1.88 (1.89) H – 2.18 (2.18) H – 1.82 (1.83) 

XMNRD [m] 2.11 - R 2.11 - R 2.08 - R 2.08 - R 

YM [m] 0 0 2.08 2.08 

ZMGND [m] H – 2.49 H – 2.49 H – 2.49 H – 2.49 

 

4.2.3 Measurement (NRD) 
1. Fill out the Project tab. In this case, Location Do denotes diffraction measurements on 

the NRD without added device). 

 

 
 

2. On the Position tab, enter the proper Source number m and Receiver number n (Table 

4, Pos tab). 

3. Open the Project window and the current project, so the Zircon software can add 

subsequent diffraction measurements to the current Group. 

4. Set the Gain slider at the same value as with the reference measurement. 

5. Click the Start button to perform the measurement. 

6. After processing the measurements, DIRAC adds 5 new diffraction impulse responses 

to the current project. 

7. Check the INR curves. 

8. If necessary, repeat the measurement with a corrected setup and/or under improved 

conditions, until the INR values are good or optimal. 

9. Save the project. 
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The project finally contains 20 free-field impulse responses and 20 diffraction impulse 

responses per position and condition. 

 

 

4.3 Processing 
1. In the Project window, from the Process menu, select Zircon. 

2. Fill out the Zircon dialog box, entering the NRD height and, if different from default, 

the Adrienne Window, as well as the name of the reference group and barrier 

measurement group without added device. 
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3. Click Process, and wait until DIRAC has created a group with the name of the processed 

measurement group, with extension “DI_0” (DI without added device), and containing 

20 new 2-channel files with the name of the processed files, also with extension “DI_0”. 

4. Repeat 2 and 3 for the measurement group with added device at the same measurement 

position, resulting in a group with name extension “DI_ad” (DI with added device) and 

containing 20 new 2-channel files with the name of the processed files, also with 

extension “DI_ad”. 

5. Check a DI Group level checkbox and select parameter DI to view the average DI of the 

20 files. 

 

 
 

 

6. The DI files contain the diffraction impulse response in channel 1 and the free-field 

impulse response in channel 2. Click a DI file and then the View the selected file 

button to view its impulse responses, including the Adrienne windows in red. 
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7. Check the Project level checkbox, and two Group level checkboxes, one without added 

device and one with added device, to view the single number rating of sound diffraction 

(DLΔDI). The example below is unusually high. 

 

 

5 Measurement Uncertainties 
Currently, an estimate of the measurement uncertainty of DI(j) at each third octave frequency 

band j and DLΔDI [dB], would best be based on the standard deviation of reproducibility. This 

requires multi-lab results and combines standard uncertainties of DI determinations to arrive at 

a Gaussian distribution. It is then common to apply a coverage factor of 1.96 to obtain a 95 % 

confidence level. For additional information, see the standards.  
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6 Appendix - LS24 and MA25 position and angle calculations 
6.1 Introduction 
In this section it is explained how to calculate the LS24 and MA25 angles and positions in 

diffraction measurements. Because the source and microphone M1 must be oriented towards 

each other, their angles, hence tripod heights and positions depend on the source position (S1 

through S4). 

 

6.2 Definitions 
Figure 2 schematically depicts an example of the top view of a diffraction measurement setup, 

with a coordinate system projected onto it. In this example, the source is located at position S3. 

Defining the NRD Measurement Position as the origin with coordinates (x, y, z) = (0, 0, 0), the 

source front reference center has position (-2, -2, -0.5) [m] and the receiver has position (2, 2, 

0.5) [m]. The tripod horizontal centers are located a bit further away from the origin. 

 

 

 
Figure 2. Definition of tripod positions relative to the NRD Measurement Position. 

 

 

Hereafter, the tripod positions and heights, as well as the source angles using setups with the 

LS24 and MA25 will be calculated for source positions S1 through S4. 
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6.3 Calculations 
Figure 3 depicts a situation with the vertical Source-Microphone plane perpendicular to the 

NRD, crossing its measurement position, and applicable to source positions S1 and S2. 

 

 
 

Figure 3. Schematic side view of setup with Source positions S1 and S2. 

 

 

From this figure and Section 6.2, the following can be noted: 

 

1. The source front center has distance dS-RP to the reference plane (RP). Its tripod/pivot 

center has distance dS-RP + xsp from the RP, while the pivot center is zsp lower than the 

source front center. It can be derived that xsp = a(cosα - sinα) and zsp = a(cosα + sinα), 

where a = 165 mm, and with dS-RP = dM-RP = 2 m, α = arctan(hSM/(dS-RP+dM-RP)) = 

arctan(hSM/4m). hSM = 1 m for source position S1, and 0.65 m for source position S2. 

2. The microphones have distance dM-RP to the RP, while their tripod center has distance 

dM-RP + xmt from the RP, where xmt = 110 mm. 

 

Figure 4 depicts a situation with the vertical Source-Microphone plane at an angle of 45° with 

the NRD, crossing its measurement position, and applicable to source positions S3 and S4. 

Compared to the previous situation, the following can be noted: 

 

1. The source front center has shifted -2 m from the test location, in the y-direction. 

2. The horizontal distance between source and microphones is a factor √2 greater, so α = 

arctan(hSM/4√2m). hSM = 1 m for source position S3, and 0.65 m for source position S4.  

3. The LS24 pivot center is located (Δx, Δy, Δz) = -a/√2·(cosα-sinα, cosα-sinα, cosα+sinα) 

with respect to the source location. 

4. The MA25 tripod horizontal center is located  (Δx, Δy) = 110/√2·(1, 1) m with respect 

to the receiver position. 

 

Table 5 shows the resulting angles and coordinates for each Source position S1 through S4. 
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Figure 4. Schematic top view of setup with Source positions S3 and S4. 

 

 

Table 5. Angles and tripod coordinates versus Sm. 

Component Parameter S1 S2 S3 S4 

LS24, MA25 Azimuth 0 0 45 45 

LS24 

Elevation 14 9 10 7 

X -2.12 -2.14 -2.09 -2.10 

Y 0 0 -2.09 -2.10 

Z -2.24 -1.88 -2.18 -1.82 

MA25 

X 2.11 2.11 2.08 2.08 

Y 0 0 2.08 2.08 

Z -2.49 -2.49 -2.49 -2.49 
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